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RESUMO 

O estresse crônico no início da vida é capaz de modificar o comportamento e 

aspectos funcionais do cérebro a longo prazo. Ele está relacionado a diversos transtornos 

psiquiátricos, dentre eles a depressão, o transtorno de ansiedade, a esquizofrenia e o abuso 

de drogas. Algumas alterações neurodesenvolvimentais são observadas antes mesmo da 

adolescência, quando muito dos pacientes apresentam início de sintomas. Identificar e 

compreender as modificações morfológicas e moleculares em resposta ao estresse durante 

janelas desenvolvimentais anteriores à puberdade é imprescindível para o melhor 

entendimento da patogenia desses transtornos, assim como para a geração de melhores 

intervenções na psiquiatria infantil. O neurodesenvolvimento depende de um microambiente 

saudável, com intensa participação de células gliais, como a micróglia. É possível que 

perturbações endógenas ou ambientais que modificam o funcionamento dessa célula imune 

no período pós-natal possam influenciar o desenvolvimento dos circuitos neurais, levando à 

maior susceptibilidade aos transtornos psiquiátricos. Ainda, a inclusão de modelos animais 

fêmeas nesse tipo de estudo é urgente, uma vez que diferenças entre os sexos são 

observadas tanto na incidência e sintomatologia de transtornos neurodesenvolvimentais 

como no funcionamento das micróglias. Nossa hipótese é que o estresse pós-natal modifica 

a densidade e morfologia de micróglias do hipocampo ventral, no curto e no longo prazo, 

mas de maneiras diferentes em machos e fêmeas. Para testá-la, camundongos transgênicos 

CX3CR1 GFP/+ foram submetidos ao estresse por separação maternal por 13 dias, e a 

densidade e morfologia de micróglias foram aferidas nos dias pós-natais 15 e 30 (P15 e 

P30). Apenas as fêmeas responderam ao estresse por separação maternal no que diz 

respeito a modificações microgliais: à curto prazo (P15) elas apresentaram diminuição da 

complexidade e tamanho celular em relação às fêmeas controle, apresentando uma 

morfologia de transição/desramificada, que perdurou até o P30. Interessantemente, tal 

morfologia é similar à de machos controle P15 e P30. Vimos que a dinâmica 

desenvolvimental das micróglias entre as idades estudadas é diferente entre os sexos, em 

que as micróglias de fêmeas tiveram modificações condizentes com uma morfologia de 

vigília enquanto machos não tiveram modificações morfológicas significantes. Em 

contrapartida, machos naive apresentaram maior densidade de micróglias no hipocampo no 

P15. Nosso trabalho aponta as micróglias como células de interesse para estudos de 

estresse pós-natal, principalmente em fêmeas. Esses resultados reiteram a importância da 

inclusão de fêmeas no estudo de micróglias e resposta ao estresse no início da vida. Por 

fim, encorajamos que estudos mais detalhados sejam feitos para elucidar as consequências 

funcionais dos resultados encontrados. 

 

 



ABSTRACT 

 

 Early life stress modifies behavior and function aspects of brain in long term. It is 

related to several psychiatric disorders, such as depression and anxiety disorder, 

schizophrenia and drug abuse. Symptoms start in adolescence and patients present 

alterations in the neurodevelopment before this period. It is crucial to unveiling cellular and 

molecular modifications in response to early life stress in windows of vulnerability prior to 

adolescence in order to better understand the pathogeny of such disorders – thus, to better 

psychiatric outcomes. The neurodevelopment relies on a healthy microenvironment, with 

major participation of glia cells, such as microglia cells. It is possible that endogenous or 

exogenous disturbance of this immune cells leads to erroneous development of neural 

circuits and increased susceptibility to stress. Importantly, the inclusion of female animal 

models is urgent, once sexual dimorphism is observed in the incidence and symptomatology 

of neurodevelopmental disorders and in microglia function.  We hypothesize that post-natal 

stress modifies the density and morphology of microglia in short and long term, but in a sex-

dependent manner. To test this hypothesis, we used a 13-days maternal separation protocol 

on CXCR1 GFP/+ transgenic mice and inquired microglia density and morphology in ventral 

hippocampus at post-natal day 15 and 30 (P15 and P30). Only females responded to early 

life stress. At short term (P15) microglia decreased their complexity and cell size, presenting 

a transition/de-ramified-like morphology – which persisted at P30. Interesting, this 

morphology is similar to male microglia morphology in both ages. We also reported sex 

differences in females in the developmental dynamics between P15 and P30 – in which 

females presented a surveillant-like microglia morphology at P30, while males did not differ 

their morphology. On the other hand, males had increased density of microglia in 

hippocampus at P15. Our work indicates microglia as a cell of interest to studies of early life 

stress, mainly in females. These results highlight the importance of inclusion of female 

models on microglia and early life stress studies. Finally, we encourage more detailed 

studies to unveil the functional consequences of the presented results. 

 

 

Palavras-chaves: Estresse, micróglia, desenvolvimento, dimorfismo sexual. 

Key words: Stress, microglia, development, sexual dimorphism. 
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1. INTRODUÇÃO 

1.1. A resposta ao estresse 

A busca pelo entendimento das respostas e adaptações físicas e psicológicas ao ambiente 

remonta a era dos filósofos gregos: Empédocles (495 a.C. - 430 a.C.) já postulava que o equilíbrio 

dos elementos constituintes da matéria era necessário para a sobrevivência (Chrousos and Gold, 

1992). Essa ideia se relaciona com o conceito de homeostase cunhado por Walter Cannon (1871-

1945), mais de 2 mil anos depois, que pode ser descrito como a manutenção da estabilidade do 

meio interno do nosso corpo em resposta às mudanças endógenas e exógenas (Brito and 

Haddad, 2017). Contudo, foi apenas em 1936 que o endocrinologista Hans Selye (1907- 1982) 

formulou o conceito de estresse, primeiramente como uma síndrome decorrente de adaptações do 

organismo frente a eventos estressores (Selye, 1936). Atualmente o conceito de estresse pode 

ser definido como uma interrupção da homeostase por fatores ambientais, fisiológicos e 

psicológicos (Chrousos and Gold, 1992). A resposta ao estresse para a manutenção da 

homeostase se denomina alostase e se dá por mediadores autonômicos, hormonais, metabólicos, 

imunológicos e comportamentais. A carga alostática é o efeito cumulativo de sucessivas 

exposições a estressores, assim como a resposta excessiva ou inadequada ao estresse (De 

Kloet, Joëls and Holsboer, 2005; McEwen et al., 2015). 

 Os principais efeitos da resposta imediata ao estímulo estressor são: aumento do 

metabolismo basal, aumento do ritmo respiratório e cardiovascular, inibição da digestão, do 

crescimento, do sistema reprodutor e do sistema imunológico. Essa resposta se dá pela ativação 

do sistema nervoso simpático, com a ativação direta de tecidos-alvo pela noradrenalina, ou pelo 

estímulo da região medular da glândula adrenal, aumentando os níveis sistêmicos de adrenalina 

(De Kloet, Joëls and Holsboer, 2005). O aumento de noradrenalina no cérebro se dá 

majoritariamente pela ativação do locus coeruleus, que envia projeções para regiões ligadas à 

resposta ao estresse, como região neocortical, límbica, hipocampo e hipotálamo (Sugama and 

Kakinuma, 2021). Durante o estresse agudo, a noradrenalina aumenta a atenção e facilita o 

processamento sensorial, aumentando assim a capacidade de consolidação de memória durante 

o estímulo estressor (Daviu et al., 2019). 

Concomitantemente à ativação simpática, ocorre a estimulação do eixo hipotálamo-

pituitária-adrenal (HPA), resultando no aumento dos níveis de glicocorticoides circulantes (figura 

1). Neurônios do núcleo paraventricular do hipotálamo secretam o hormônio liberador de 

corticotrofina (CRH, do inglês corticotropin-release hormone) e arginina vasopressina no sistema 

porta-hipofisário. Esses hormônios ativam a síntese de pro-opiomelanocortina (POMC) na 

pituitária anterior, que é então clivada em corticotrofina (ACTH, do inglês adrenocorticotropic 

hormone) e outros peptídeos. O ACTH atinge a circulação e estimula o córtex adrenal a secretar 
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glicocorticoides – cortisol em humanos e corticosterona em roedores (De Kloet, Joëls and 

Holsboer, 2005). O eixo HPA apresenta uma via de feedback negativo, em que glicocorticoides 

controlam sua própria liberação por inibição do eixo via glândula adrenal, hipotálamo e hipocampo 

ventral (Jacobson and Sapolsky, 1991; Herman et al., 2005). Outras regiões límbicas também 

participam do controle desse eixo, como o córtex pré-frontal medial (CPFm), que pode tanto inibi-

lo quanto ativá-lo (Diorio, Viau and Meaney, 1993; Sullivan and Gratton, 1999); e a amígdala, que 

exerce um papel majoritariamente de ativação do eixo, aumentando os níveis de glicocorticoides 

circulantes (Feldman and Weidenfeld, 1998; Herman et al., 2005).   

 

 

 Figura 1. Eixo hipotálamo-pituitária-adrenal. Em resposta a um evento estressor, neurônios do 

hipotálamo liberam os hormônios CRH e AVP, que estimulam corticotrofos da pituitária anterior (ou 

adenohipófise) a liberar ACTH. O ACTH cai na corrente sanguínea e age no córtex da glândula adrenal 

aumentando a liberação de glicocorticoides. Estes controlam tanto a liberação de CRH quanto a liberação 

de ACTH por mecanismos de feedback negativo. Além do feedback negativo, o controle do eixo HPA 

também é feito pelo hipocampo, o córtex pré-frontal e a amígdala. CRH. Hormônio liberador de 

corticotrofina; AVP. Arginina vasopressina; ACTH. Corticotrofina; GR. Receptor glicocorticoide; MR Receptor 

mineralocorticoide (adaptado de LUPIEN et al., 2009). 
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O cortisol/corticosterona é um dos principais hormônios reguladores do estresse e atua por 

meio de dois receptores: os receptores de glicocorticoides (GR) e mineralocorticoides (MR), sendo 

que o primeiro apresenta uma afinidade 10 vezes menor que o segundo. Os MR atuam 

majoritariamente em condições fisiológicas/homeostáticas, como na variação circadiana (Russell 

and Lightman, 2019), assim como na resposta inicial ao estresse (De Kloet, Joëls and Holsboer, 

2005; Karst et al., 2005). Quando o cortisol atinge altas concentrações, ele passa a ativar também 

os GR. Glicocorticoides podem regular cascatas intracelulares, metabolismo celular e liberação de 

neurotransmissores excitatórios e inibitórios por meio de sua translocação para mitocôndrias ou 

interação com o sistema endocanabinoide (McEwen et al., 2015). O mecanismo de regulação 

mais bem conhecido é a regulação epigenética, que se dá pela interação do complexo 

glicocorticoide-receptor com fatores de transcrição ou pela sua ligação direta em regiões 

específicas do DNA, conhecidas como “Elementos de Resposta de Glicocorticoide”. Essa 

complexa interação facilita a adaptação a próximos eventos estressores, assim como o controle 

do próprio eixo HPA por meio da inibição de peptídeos como o CRH e mudança no perfil de 

receptores das regiões envolvidas no feedback negativo (De Bosscher, Vanden Berghe and 

Haegeman, 2003; De Kloet, Joëls and Holsboer, 2005). 

O estresse crônico gera a desregulação do feedback negativo do eixo HPA: ratos e 

camundongos submetidos a estresse crônico apresentam resposta exagerada do eixo, com 

aumento de corticosterona e CRH (Figueiredo et al., 2003; Hu et al., 2020). Esse efeito também 

pode ser visto em humanos: pacientes com depressão apresentam hipercortisolemia, 

hipersensibilidade da glândula adrenal e outras mal adaptações do eixo HPA (Parker, Schatzberg 

and Lyons, 2003; Nikkheslat et al., 2020), enquanto pacientes com transtorno pós traumático 

tendem a apresentar o nível de cortisol sistêmico diminuído (Pan et al., 2018). A carga alostática 

gerada pelo estresse crônico também causa modificações nas estruturas que participam do 

feedback negativo, majoritariamente por efeitos epigenéticos (Gray et al., 2014). Há diminuição de 

potencial de longa duração (LTP) no hipocampo e CPF (Alfarez, Joëls and Krugers, 2003) e atrofia 

de dendritos na região CA3 do hipocampo (Magarin õs and McEwen, 1995). Há diminuição da 

proliferação e apoptose celular no hipocampo de ratos machos após o estresse crônico, que é 

parcialmente recuperada a longo prazo (Heine et al., 2004). Em contradição ao estresse agudo, 

que aumenta os níveis de monoaminas no cérebro (De Kloet, Joëls and Holsboer, 2005), o 

estresse crônico diminui a concentração de dopamina no hipotálamo, córtex frontal e hipocampo; 

e diminui o turnover de serotonina no hipocampo de roedores machos (Bowman, Beck and Luine, 

2003; Gamaro et al., 2003; Favoretto et al., 2020). 
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É evidente que a resposta ao estresse exige a interação de diversos sistemas e é capaz 

de gerar modificações duradouras, nem sempre adaptativas. Dessa maneira, é importante que 

seus mecanismos sejam elucidados não apenas no cérebro adulto, já maduro, mas também em 

outras fases do desenvolvimento. 

   

1.2. Estresse e neurodesenvolvimento 

Neurodesenvolvimento refere-se à formação e maturação do sistema nervoso que vai do 

período embrionário até o início da vida adulta. Durante esse período, diversos processos são 

influenciados pelo ambiente externo. Um exemplo é o sistema visual, em que o fechamento de um 

dos olhos em um período específico do desenvolvimento leva à inputs mais fortes no córtex visual 

ipsilateral (Huang, 2019). Essa influência não é vista apenas no sistema sensorial: a exposição 

viral materna de camundongos prenhes modifica mais intensamente parâmetros neuroanatômicos 

quando feita no início da gestação comparada à exposição tardia. O perfil comportamental e de 

transcrição gênica também é modificado de maneira idade-dependente (Guma et al., 2021). 

Durante o desenvolvimento pós-natal, diferentes protocolos de estresse em janelas 

desenvolvimentais variadas levam a diferentes perfis de resiliência ou susceptibilidade a um 

segundo estresse na fase adulta em camundongos machos (Peña, Nestler and Bagot, 2019). 

Mesmo alterações curtas na neurotransmissão monoaminérgica já são capazes de modificar 

parâmetros moleculares e comportamentais a longo prazo. Tanto o aumento quanto a diminuição 

de dopamina na fase embrionária modificam o número de neurônios GABAérgicos e o 

comportamento de peixes zebra (Danio Rerio) (Souza, Romano-Silva and Tropepe, 2011). Já a 

hiperativação transiente de receptores dopaminérgicos nos primeiros 5 dias pós-natal em 

camundongos é capaz de induzir comportamento tipo ansioso em fêmeas adultas e 

comportamento tipo depressivo em machos jovens (DE MATOS et al., 2018; MATOS et al., 2020; 

Moraes et al., em preparação). Eventos que acontecem na vida uterina, infância e adolescência 

podem influenciar o desenvolvimento do cérebro em diferentes níveis, tendo consequências 

duradouras.  

 Diversos transtornos psiquiátricos apresentam uma hipótese desenvolvimental. Estudos 

epidemiológicos apontam o estresse crônico ou eventos traumáticos no início da vida como fator 

de risco para o desenvolvimento de transtornos depressivos, de ansiedade, esquizofrenia, 

transtorno do uso de substância, dentre outros (Jaaro-Peled et al., 2009; Kessler et al., 2010; 

Reiser et al., 2014). No caso da depressão, esse risco chega a ser 4 vezes maior para adultos que 

passaram por sucessivos eventos adversos na infância (Felitti et al., 2019). Na adolescência, 

época em que naturalmente ocorre um pico de diagnósticos (Rohde et al., 2013), o risco é 
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aumentado em cerca de 2,5 vezes, sendo esse efeito mais pronunciado em jovens mulheres 

(Gallo et al., 2017; Lemoult et al., 2019). 

 Estudos com humanos apontam que o estresse crônico na infância causa alterações 

cerebrais anatômicas e cognitivas. Eventos traumáticos e abusos na infância diminuem o volume 

do hipocampo e aumentam o volume do CPF em adultos (Hart, Rubia and Angiulli, 2012; Riem et 

al., 2015; Nikkheslat et al., 2020). Alterações volumétricas e cognitivas podem ser vistas ainda na 

infância e adolescência: crianças vítimas de maus tratos e abandono apresentam déficits de 

memória, atenção e no processamento de emoções. O volume cerebral é menor nessas crianças, 

e foi visto tanto aumento como diminuição do volume do CPF e amigdala de crianças e 

adolescentes que passaram por situações traumáticas na infância (Hart, Rubia and Angiulli, 2012). 

A diminuição do volume e atividade hipocampal começa a ser evidente no final da infância e início 

da adolescência (Carrion, Weems and Reiss, 2007; Carrión et al., 2010). 

Durante o início da vida, o eixo HPA encontra-se em um período chamado de “período 

hiporresponsivo ao estresse”, uma fase de hiperresponsividade que confere proteção contra a 

estimulação excessiva por glicocorticoide (Sapolsky and Meaney, 1986; Levine, 1994). Em 

roedores esse período vai do segundo ao décimo quarto dia pós-natal (P2-P14) e ele está 

presente nos primeiros anos de vida em humanos (Gunnar and Cheatham, 2003; Lupien et al., 

2009). O cuidado materno em roedores - contato físico, amamentação e lambida da região 

urogenital – estimula essa diminuição da atividade do eixo HPA. Ao separar os filhotes da mãe, 

esse período pode ser interrompido, sendo evidenciada uma potente resposta e desregulação do 

eixo HPA (Plotsky and Meaney, 1993; Levine, 1994). É possível que a atividade aumentada do 

eixo em uma fase desenvolvimental em que ela “deveria” estar reduzida interfira com outros 

aspectos do neurodesenvolvimento, contribuindo para maior susceptibilidade do indivíduo à 

estresses futuros.  

A separação maternal é um modelo eficaz para o estudo de estresse crônico ou traumas 

no início da vida. Em 1993, Plotsky e Meaney viram que os ratos machos separados da mãe por 

períodos longos (180min) apresentaram aumento de CRH no hipotálamo (Plotsky and Meaney, 

1993). Posteriormente, foi visto que após a separação maternal os filhotes de ratos e 

camundongos apresentam resposta exagerada do eixo HPA a um novo estressor, o que perdura 

até a idade adulta (Kuhn and Schanberg, 1998; Aisa et al., 2007; Nishi, Horii-Hayashi and 

Sasagawa, 2014).  

O protocolo de separação maternal também leva a modificações comportamentais na fase 

adulta. Devido às variações usadas em diferentes protocolos de separação maternal em 

camundongos, tais modificações são diversas. Uma meta-análise feita por Tractenberg e 

colaboradores (2016) evidenciou que as consequências comportamentais mais consistentes em 
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camundongos são o aumento do comportamento tipo depressivo e déficit de memória, seguido do 

aumento do comportamento tipo ansioso dos animais (Tractenberg et al., 2016). Tanto o 

comportamento do tipo ansioso quanto depressivo já podem ser observados em camundongos 

jovens (Shin et al., 2016; He et al., 2020). Em contrapartida, o déficit de memória é menos 

observado nessa fase desenvolvimental (Reis et al., em preparação; SHIN et al., 2016).  

A inclusão de modelos animais fêmeas é de extrema importância para o entendimento da 

vulnerabilidade aos transtornos relacionados ao estresse, uma vez que o estresse no início da 

vida também apresenta viés de sexo. Ratos machos submetidos ao protocolo de estresse 

apresentam déficit de atenção no início da adolescência, enquanto fêmeas apresentam melhoras 

cognitivas nos testes utilizados (Frankola et al., 2010). Camundongos machos são mais 

responsivos ao protocolo de separação maternal, porém há uma falta de estudos incluindo fêmeas 

para avaliação mais profunda (Tractenberg et al., 2016; He et al., 2020). Estudos prévios do nosso 

laboratório mostraram que apenas machos jovens apresentam aumento de comportamento tipo 

ansioso e depressivo em resposta ao estresse na infância (Reis et al., em preparação, Menezes et 

al., em preparação). Interessantemente, há evidências de que na fase adulta esse fenótipo pode 

se inverter (Bondar, Lepeshko and Reshetnikov, 2018).  

 Análises morfológicas de roedores que passaram pela separação maternal também 

corroboram com achados clínicos de pacientes que passaram pelo estresse na infância, como 

diminuição do volume hipocampal (Aksić et al., 2013). Essa diminuição pode estar ligada com a 

perda celular ou com a diminuição do comprimento dendrítico e número de espinhas dendríticas 

vista no hipocampo (Fabricius, Wörtwein and Pakkenberg, 2008; Monroy, Hernández-Torres and 

Flores, 2010). A separação maternal também leva à diminuição de LTP em CA3 e modificações 

dendríticas no CPF e núcleo acumbens de ratos (Monroy, Hernández-Torres and Flores, 2010; 

Shin et al., 2016). Mesmo sem a presença de um fenótipo comportamental claro, modificações 

decorrentes do estresse na infância são observadas, como a modificação de micróglias em 

camundongos adultos (Han et al., 2019).  

 Visto a extensão das modificações decorrentes do estresse na infância, torna-se 

imprescindível a compreensão dos mecanismos celulares e moleculares envolvidos na resposta 

ao estresse pós-natal - principalmente daqueles que foram por muito tempo desconhecidos ou 

pouco explorados, como o papel das células gliais nesse processo. 

 

1.3. A micróglia como ator fundamental do neurodesenvolvimento 

As micróglias são células do sistema imune residentes do cérebro. Ao contrário do que se 

pensava inicialmente, essas células não são derivadas de monócitos circulantes, tendo expressão 

proteica e marcadores celulares próprios (Butovsky et al., 2014). Elas começam a diferenciação 
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ainda no saco vitelino e infiltram o cérebro no período embrionário – por volta da semana 

embrionária 4,5 e 5 em humanos e dos dias embrionários 8-10 em roedores (Ginhoux et al., 2010; 

Mosser et al., 2017).   

As micróglias ganharam grande interesse por sua resposta inflamatória e sua participação 

em doenças neurodegenerativas, como na doença de Parkinson e Alzheimer (Yoon Seong and 

Tong H., 2006; Krasemann et al., 2017). Ela também é essencial para o neurodesenvolvimento 

(figura 2). Durante o desenvolvimento pós-natal, células nervosas passam por um processo 

chamado de morte celular programada, em que grande parte dos neurônios sofre apoptose. As 

micróglias respondem a esse processo fagocitando células em processo de apoptose ou 

fragmentos celulares, e podem participar ativamente induzindo a morte celular através de 

mediadores solúveis ou contatos diretos (Ferrer et al., 1990; Sierra et al., 2010; Bilimoria and 

Stevens, 2015). Elas também estão envolvidas no controle da sobrevivência neuronal e 

proliferação de células precursoras (Antony et al., 2011; Ueno et al., 2013).  

As micróglias apresentam um papel crucial na maturação sináptica dos neurônios. Sua 

atividade mais bem descrita é a participação na poda sináptica, fenômeno que ocorre no 

desenvolvimento pós-natal e é responsável pela eliminação de sinapses tanto de maneira 

espontânea quanto dirigida por experiência. Micróglias engolfam inputs pré-sinápticos das células 

ganglionares da retina no pico da poda sináptica (Schafer et al., 2012), e estão envolvidas na 

poda sináptica do hipocampo de camundongos nas primeiras semanas pós-natais. A poda 

sináptica deficiente decorrente da deleção da proteína CX3CR1, majoritária de micróglias no 

sistema nervoso central, gera excesso de espinhas dendríticas e atraso da maturação de sinapses 

nessa região (Paolicelli et al., 2011). As micróglias também participam do refinamento de circuitos 

neurais. Tremblay e colaboradores (2010) demonstraram que micróglias presentes no córtex 

visual contactam terminais sinápticos, fenda sináptica e espinhas dendríticas, principalmente as 

menores – as quais somem posteriormente ao contato (Tremblay, Lowery and Majewska, 2010). 

Lim e colaboradores viram que micróglias são capazes de promover sinapses em culturas de 

células hipocampais (Lim et al., 2013).  

 Desse modo, perturbações endógenas ou ambientais que modificam o funcionamento de 

micróglias no período pós-natal podem influenciar o desenvolvimento dos circuitos neurais, 

fazendo dessa célula um importante alvo de pesquisas no campo de transtornos 

neurodesenvolvimentais. 
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Figura 2. Papel da micróglia no desenvolvimento do sistema nervoso central. A. Ilustração da 

participação de micróglias na morte celular programada de neurônios imaturos e em apoptose, por meio de 

mediadores químicos, e fagocita corpos apoptóticos. B. Processo de poda sináptica pela micróglia. Ela 

reconhece elementos pré-sinápticos por meio do sistema complemento e engloba botões sinápticos, 

eliminando-os. C. Participação da micróglia na formação sináptica por mediadores químicos. Adaptado de 

Mosser et al. 2017 

  

1.4. Micróglias e transtornos neuropsiquiátricos 

Na última década, as publicações que investigam o papel da micróglia em transtornos 

psiquiátricos cresceram cerca de 5 vezes (PubMed), ao passo que as evidências dessa relação se 

acumulam. Estudos com pacientes dentro do espectro autista mostraram que há aumento de 

densidade de micróglias em diferentes regiões corticais, além de modificações morfológicas 

compatíveis com uma maior ativação (Koyama and Ikegaya, 2015). Pacientes esquizofrênicos ou 

em grande risco para psicose também apresentam aumento de atividade dessas células. 

Interessantemente, a minociclina, um antibiótico capaz de inibir a ativação microglial, é capaz de 

atenuar sintomas negativos da esquizofrenia e promover neuroproteção em modelos animais 

adultos (Inta et al., 2017). Pacientes com depressão apresentam aumento de micróglias 

sensibilizadas – ou primed - no córtex cingulado anterior (Torres-Platas et al., 2014; Yirmiya, 

Rimmerman and Reshef, 2015). Estudos genéticos apontam genes presentes em micróglias como 

fator de risco para depressão e transtorno bipolar, como o gene P2RX7 (Barden et al., 2006; 

Lucae et al., 2006; Frost and Schafer, 2016). O transplante de micróglias de animais controle 
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melhora o grooming do camundongo mutante para Hoxb8, usado como modelo de desordem 

obsessiva compulsiva (Chen et al., 2010). 

A infecção materna no período pré-natal também está envolvida com o aumento do risco 

para o desenvolvimento de esquizofrenia e transtorno do espectro autista (Shi et al., 2003; 

Atladóttir et al., 2010; Brown, 2012; Knuesel et al., 2014). Modelos animais de infecção materna 

são úteis para estabelecer uma relação causal entre esses achados epidemiológicos. Nesses 

modelos, fêmeas prenhes passam por um desafio imune através da exposição viral ou à 

fragmentos de bactérias (Paolicelli and Ferretti, 2017). A ativação imune sistêmica causada pela 

infecção é seguida pela ativação imune mediada por micróglias no cérebro. Tal ativação no 

sistema nervoso central também foi relata nos filhotes, tanto no período do desafio imune quanto 

posteriormente: a prole adulta apresenta comportamento tipo ansioso, déficits cognitivos e 

diminuição do comportamento social, além de modificações em receptores NMDA (Hava et al., 

2006; Kirsten et al., 2010; Paolicelli and Ferretti, 2017). O desafio imune materno também 

promove o priming de micróglias hipocampais na prole, deixando-as mais reativas a um segundo 

estressor na idade adulta (Forrest et al., 2012; Giovanoli et al., 2016). 

Outros estímulos ambientais também podem influenciar a resposta inflamatória sistêmica e 

cerebral, como o estresse. De fato, micróglias são capazes de responder diretamente ao estresse, 

uma vez que apresentam receptores para glicocorticoides e noradrenalina. A ativação da micróglia 

por agonistas adrenérgicos diminui a produção de citocinas inflamatórias, como IL-6 e TNFa, e 

suprime a sua proliferação (Pocock and Kettenmann, 2007). Níveis elevados de glicocorticoides 

também inibem a ativação pró-inflamatória da micróglia no hipocampo e hipotálamo e são 

importantes para o processo de priming da micróglia após um estresse agudo em ratos adultos 

(Ros-Bernal et al., 2011; Frank et al., 2012; Sugama et al., 2013; Johnson and Kaffman, 2018). As 

micróglias também participam do controle da ativação do núcleo paraventricular do hipotálamo e 

dos níveis de ACTH e corticosterona circulantes em resposta ao estresse agudo (Winkler et al., 

2017). Já o estresse crônico imprevisível em roedores adultos machos está ligado ao aumento de 

densidade e modificações da morfologia de micróglias em diversas regiões, dentre elas 

hipocampo e CPF, além de aumento do comportamento tipo depressivo (Tynan et al., 2010; 

Delpech et al., 2015; Piirainen et al., 2021). 

Diferentes modelos de estresse perinatal modificam a atividade microglial de maneira 

aguda ou duradoura, ou seja, mesmo após a ausência do estressor. Por exemplo, camundongos 

adultos filhos de mães estressadas na gravidez apresentam alterações microgliais no hipocampo, 

como aumento de densidade, soma mais alargado, aumento de expressão de citocinas 

inflamatórias e resposta exacerbada a um desafio imunológico com LPS (Diz-Chaves et al., 2012, 
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2013). Dessa forma, é possível que micróglias sejam uma peça-chave em transtornos decorrentes 

da exposição ao estresse.  

 O estresse pós-natal leva ao comportamento tipo depressivo em ratos e camundongos 

adultos concomitantemente com modificações nas células microgliais. A separação maternal 

diminui a densidade e provoca atrofia de micróglias no giro denteado do hipocampo de ratos 

machos e fêmeas adultos (Gong et al., 2018). Tal redução está ligada ao processo de apoptose 

microglial, induzido pela sua própria ativação. A inibição da micróglia nos primeiros dias de 

separação maternal impede a perda de micróglias no hipocampo e o aparecimento do fenótipo 

tipo depressivo. Em contrapartida, foi observado aumento do número de micróglias no hipocampo 

total e na região CA3 em machos adultos estressados na infância (Banqueri et al., 2019; Zhou et 

al., 2020). A separação maternal também aumenta o número de processos de células microgliais 

e sua mobilidade no córtex somatossensorial; e a atividade pró-inflamatória no estriado, núcleo 

acumbens e hipocampo dorsal de ratos e camundongos machos adultos (Takatsuru et al., 2015; 

Banqueri et al., 2019). É interessante investigar quais as consequências da micróglia também no 

hipocampo ventral, uma vez que essa região está mais relacionada ao controle emocional e do 

feedback negativo do eixo HPA, além de estar desregulada em transtornos psiquiátricos 

relacionados ao estresse crônico (Herman et al., 2005).  

As consequências do estresse no início da vida nas micróglias podem ser diferentes 

dependendo da janela desenvolvimental investigada. Logo após a separação maternal, há 

aumento de densidade e ativação microglial em camundongos e ratos machos, com aumento da 

expressão de citosinas pró-inflamatórias no hipocampo e CPF (Delpech et al., 2016; Roque, 

Ochoa-Zarzosa and Torner, 2016; Giridharan et al., 2019). O aumento do comportamento tipo 

ansioso e tipo depressivo concomitante às modificações microgliais já pode ser visto na 

adolescência em camundongos machos e pode ser revertido com minociclina (Gracia-Rubio et al., 

2016; Han et al., 2019). Dentre a fase inicial (P28) e final (P56) da adolescência de camundongos 

machos foi vista alteração da transcrição gênica de imunorreguladores e da atividade fagocitária 

em micróglias, além do aumento da expressão de IBA 1 (marcador de micróglia) e diminuição de 

ramificações e tamanho dos processos dessas células no hipocampo, mas sem a alteração de 

densidade nos animais estressados (Delpech et al., 2016; Gracia-Rubio et al., 2016; Han et al., 

2019). Elucidar alterações microgliais em fases desenvolvimentais distintas é importante para 

compreendermos suas consequências em diferentes janelas de susceptibilidade. Enquanto o 

início da vida é marcado pela sinaptogênese, poda sináptica e organização funcional de circuitos 

neurais, a adolescência é marcada pela segunda onda de poda sináptica e remodelação desses 

circuitos. 
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 O dimorfismo sexual também foi relatado em micróglias, mas as diferenças encontradas 

ainda são difusas e pouco estudadas (Kodama and Gan, 2019). A quantidade de micróglias no 

hipocampo de ratos na primeira semana de vida é diferente entre os sexos, mas esse número já 

foi descrito sendo maior tanto em machos quanto em fêmeas. Ainda na primeira semana, 

micróglias de ratas apresentam maior atividade fagocitária no hipocampo e diferem na expressão 

de quimiocinas (Schwarz, Sholar and Bilbo, 2012; Nelson, Warden and Lenz, 2017a). Já a 

densidade dessas células em camundongos é maior em machos no P21 e no P91 (Guneykaya et 

al., 2018). Diferenças expressivas no transcriptoma de micróglias de machos e fêmeas são mais 

evidentes na idade adulta, mas não há conclusão se essa diferença confere atividade mais 

inflamatória ou protetiva para algum dos sexos (Guneykaya et al., 2018; Kodama and Gan, 2019).  

O dimorfismo sexual se reflete na resposta ao estresse no início da vida. Machos e fêmeas 

adolescentes e adultas que passaram pelo estresse por separação maternal apresentam 

comportamento tipo depressivo, mas apenas fêmeas adultas apresentam comportamento tipo 

ansioso. Tais comportamentos são acompanhados de aumento de IBA-1 apenas no PFC e 

hipocampo de fêmeas, mas aumentam a morfologia responsiva de micróglias em ambos os sexos 

(Gracia-Rubio et al., 2016; Saavedra et al., 2021). Ainda, o estresse na infância levou à maior 

resposta de medo em fêmeas adolescentes, corpos celulares maiores no CPF de fêmeas e 

redução de células gliais na substância negra e núcleo acumbens apenas de machos (Chocyk et 

al., 2011; Gildawie et al., 2020a; Zetter et al., 2021). Entender a dinâmica desenvolvimental de 

micróglias também em fêmeas se torna interessante, assim como caracterizar como essas 

diferenças intrínsecas podem levar a respostas ao estresse distintas nas micróglias desses 

animais.  

A maioria dos trabalhos explora as consequências do estresse infantil na vida adulta de 

animais machos, deixando uma lacuna no nosso conhecimento referente à resposta neuroimune e 

glial em estágios desenvolvimentais anteriores e em fêmeas. Preencher essa lacuna é essencial 

para desvendarmos a patogenia de transtornos neuropsiquiátricos relacionados ao estresse.  

Nesse trabalho investigamos as consequências do estresse pós-natal na micróglia do 

hipocampo ventral de camundongos machos e fêmeas em duas importantes janelas 

desenvolvimentais - P15 e P30 -, reunindo em um único estudo as duas variáveis: período 

desenvolvimental e sexo. Nossa hipótese é a de que o estresse pós-natal modifica a densidade e 

morfologia de micróglias tanto no curto e no longo prazo, mas de maneiras diferentes em machos 

e fêmeas.  
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2. OBJETIVO 

O objetivo deste trabalho foi investigar se o estresse pós-natal é capaz de modificar a 

densidade e morfologia de micróglias hipocampais de camundongos machos e fêmeas.  

2.1. OBJETIVOS ESPECÍFICOS 

• Investigar diferenças etológicas entre os sexos na densidade e 

morfologia de micróglias em duas janelas desenvolvimentais distintas; 

• Investigar se o protocolo de separação maternal é capaz de modificar a 

densidade e morfologia de micróglias hipocampais após o período de 

estresse;  

• Investigar se o protocolo de separação maternal é capaz de modificar a 

densidade e morfologia de micróglias hipocampais no período do início 

da adolescência; 

• Investigar se a densidade e morfologia de micróglias de machos e 

fêmeas é diferente em resposta ao estresse. 

  

3. MATERIAL E MÉTODOS 

3.1. Animais Experimentais 

Camundongos fêmeas C57/BL6 wild type (WT) e machos da linhagem C57/BL6 

CX3CR1:GFP+/+, com 12 a 24 semanas, foram utilizados como matrizes. Os animais foram 

mantidos em temperatura ambiente de 22 ±1°C e umidade 40-70%, em ciclo claro-escuro de 

12/12 horas, com livre acesso à ração e água. Todas os experimentos foram feitos sob aprovação 

prévio do CEUA, protocolo n°260/2019. 

Os cruzamentos foram realizados na proporção de 2 fêmeas para 1 macho durante um 

período de 7 a 10 dias. Após esse período, as fêmeas foram separadas dos machos, sendo 

mantidas em caixas com 2 a 4 animais. No provável 19º dia de gestação as fêmeas foram 

transferidas para caixas individuais e acompanhadas até o dia de nascimento dos filhotes (P1). 

Todos os animais utilizados apresentaram genótipo heterozigoto (CX3CR1:GFP+/-), decorrente do 

cruzamento de animais homozigotos.  

As ninhadas foram padronizadas contendo entre 5 a 8 filhotes, que foram mantidos com as 

respectivas mães até o 23º dia pós-natal (P23). No P23 as ninhadas foram separadas de acordo 

com o sexo e mantidas em caixas com 2 a 4 animais, nas condições descritas anteriormente. 
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3.2. Desenho experimental 

As ninhadas foram divididas em dois grupos experimentais: um que não passou por 

nenhum tipo de estresse, sendo considerado o controle, denominado naive; e o grupo que passou 

pelo estresse de separação maternal (SM). As idades de 15 e 30 dias (P15 e P30) foram 

investigadas para o estudo dos efeitos SM um dia após o fim do protocolo (curto prazo) e duas 

semanas após o fim do protocolo (longo prazo) (figura 3). 

O protocolo de estresse por separação maternal consistiu em separar os filhotes de sua 

mãe por 3 horas, durante 13 dias (P2-P14), em horários randomizados entre 8h-17h (ciclo claro). 

Durante o protocolo, os animais foram mantidos isolados em potes individuais, com maravalha 

limpa, aquecidos em banho maria à temperatura de 32°C +- 2°C.  

 

 

 Figura 3: Desenho experimental. Os animais passam pela separação maternal entre o P2 e P14. 

A eutanásia dos animais foi feita no P15 ou P30. Imagens: Biorender 

 

A eutanásia ocorreu na parte da tarde para todos os animais. Os animais foram 

anestesiados com uma combinação de xilazina (10mg/Kg), cetamina (100mg/Kg) e salina por via 

intraperitoneal. Na indicação de perda total da sensibilidade, foi realizada perfusão cardíaca com 

5ml de tampão fosfato salina [PBS: 0,1 M (0,387M NaH2PO4.H2O, 0,612 M Na2HPO4.7H2O, 1,4 

M NaCl); pH=7,4;] e 5ml de paraformaldeído 4% diluído em PBS para os animais P15 e 10ml para 

os animais P30. Os cérebros foram armazenados em PFA 4% por 3 horas e então transferidos 

para solução de sacarose 30%.  

Os cérebros foram fatiados em criostato à -21°C, numa espessura de 60μm. As fatias que 

continham o hipocampo ventral foram armazenadas em solução crioprotetora (sacarose 30% m/v, 
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polivinilpirrolidona PVP 1% m/v, PBS 10% e etileno glicol 30% v/v), à -20°C, até a aquisição de 

imagens. 

 

3.3. Marcações celulares 

3.3.1. Micróglias 

O animal C57BL/6 CX3CR1:GFP +/- tem um locus do gene codificador do receptor 

CX3CR1 trocado por um gene para expressão de EGFP (Jung et al., 2000). Esse receptor é 

expresso majoritariamente em micróglias no sistema nervoso (Wolf et al., 2013), dessa maneira 

não foi preciso nenhuma marcação extra para esse tipo celular. 

Esse modelo é amplamente usado nas pesquisas envolvendo micróglias e a função deste 

receptor, por permitir seu estudo in vivo e pela especificidade celular. O uso do animal 

heterozigoto é um excelente controle, pois não há diferença fenotípica significativa deste em 

comparação ao WT (Jung et al., 2000; Wolf et al., 2013), inclusive em testes comportamentais 

(Reshef et al., 2014). 

 

3.3.2. Núcleo celular 

Os núcleos celulares foram marcados com DAPI (1:10000μl) para permitir a posterior 

divisão das sub-regiões hipocampais, como ilustrado na figura 4A. As fatias ficaram imersas em 

300μl de solução com DAPI por 10 minutos e em seguida lavadas com PBS 0,1M por 5 minutos. 

 

 Figura 4. Fotomicrografias brutas. (A.) Desenho ilustrativo das sub-regiões do hipocampo ventral 

em fotomicrografia corada com DAPI, 4x. Escala: 500µm (B.) Imagem representativa do giro denteado no 
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aumento de 10x. Escala:500µm (C.) Imagem representativa da reconstrução de 6 “stacks” em aumento de 

60x. Escala: 50µm; S: Subículo, GD: Giro denteado. 

 

 

3.4. Aquisição e Análise de Imagens 

A aquisição das imagens foi feita com microscopia confocal, utilizando microscópio Nikon 

Eclipse Ti, em colaboração com o laboratório Center of Gastrointestinal Biology (ICB-UFMG). A 

região de interesse foi o hipocampo ventral e foram feitas imagens de fatias entre o bregma -

2,70mm e -2,80mm referentes ao mapeamento de Paxinus e Franklin, 2001. Fizemos 

fotomicrografias em menor aumento (objetiva de 4X), para ter uma foto panorâmica do 

hipocampo, e em maior aumento (objetivas de 10X e 60X; figura 4B-C), para as seguintes 

quantificações.  

O software ImageJ/FIJI foi utilizado para todas as análises. Para um resumo dos 

parâmetros analisados, veja a tabela 2. Para a lista detalhada de comandos utilizados, veja o 

anexo 1. 

3.4.1. Análise de Densidade  

Para a análise de densidade de micróglias, foram utilizadas as fotografias no aumento de 

10X (figura 5), em duplicata. Primeiramente, delimitamos as sub-regiões do hipocampo na 

imagem da marcação por DAPI e medimos a área da sub-região através da função de medição 

(measure) do ImageJ. Em seguida, passamos essa marcação para a imagem com GFP, já 

convertida em imagem binária. Para a conversão em imagem binária, utilizamos a função 

“threshold”, que permite separar a imagem do seu fundo. Utilizamos a função de análise de 

partículas (Analyze Particles) com delimitações 6 - ꝏ µm para a contagem de células microgliais. 

A densidade foi calculada dividindo o número de micróglias pela área da região correspondente. 

 



29 
 

 

 Figura 5. Análise de densidade. (A) Fotomicrografia GFP 10x bruta e convertida em 

imagem binária. (B) Marcação da região de interesse na fotomicrográfia com DAPI. (C) Conta da 

densidade. Escala: 500µm.  

 

3.4.2. Análise de Ramificações 

Micróglias são células extremamente plásticas. Elas são capazes de modificar sua 

morfologia em resposta a mudanças em seu microambiente, retraindo suas ramificações 

(Sominsky, Luca and Spencer, 2018). Dessa maneira, investigamos se o estresse crônico na 

infância provoca a modificações das ramificações microgliais a curto e longo prazo.  

Existem diversas maneiras de analisar a morfologia das micróglias. Aqui, utilizamos a 

análise de ramificações através do protocolo de esqueletonização, segundo publicado por Young 

e Morrison (Young and Morrison, 2018), com pequenas modificações. Utilizamos as 

fotomicrografias de 60X, em série Z a cada micrômetro de profundidade. Fizemos a montagem da 

série Z contendo 6 “stacks”. O contraste foi ajustado de modo que os prolongamentos ficassem o 

mais evidentes possível. Apenas células em que o corpo celular estava contido na imagem foram 
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consideradas, as demais foram apagadas. O restante do procedimento de binarização e 

esqueletonização foi feito de acordo com o artigo citado. Para detalhes, veja o anexo 1.  

O plugin de esqueletonização remove repetidamente os pixels externos de uma imagem 

binária até essa imagem ser reduzida a um formato de apenas 1 pixel (figura 6). Já o plugin de 

análise (Analyze Skeleton Plugin) reconhece todos os pixels/voxels de uma imagem 

esqueletonizada e diferencia os pixels de junções daqueles de ramificação, e mede seu 

comprimento médio e máximo. Ele também é capaz de reconhecer os pixels/voxels terminais das 

ramificações (enpoints) (figura 6). Neste trabalho nós somamos a quantidade de pixel/voxels 

terminais das ramificações e comprimento dos processos (extraídos automaticamente pelo plug-

in) e normalizamos pelo número de células contidas na imagem. Os parâmetros nos dão 

informação do número de ramificações (N° de ramificações/cel) e comprimento médio das 

ramificações (Comp. Ramificações/cel) de uma fotomicrografia, respectivamente (Tabela 2). 

 

 

 Figura 6. Processo de esqueletonização. (A) Primeiramente a imagem original é convertida para 

binária e então esqueletonizada. A última coluna mostra a sobreposição do esqueleto na imagem original. O 

zoom dos quadrados brancos é detalhado embaixo. Escala 10µm. (B) Ilustração da análise feita pelo plug-

in.  
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3.4.3. Análise de Fractal 

A análise de esqueletonização nos dá um panorama de como está o conjunto celular, mas 

é limitada à análise de ramificações. Para uma análise mais minuciosa da morfologia das 

micróglias, utilizamos o protocolo de análise de fractal, também descrito por Young e Morrison 

(2018), que conta com a utilização do plugin FracLac do ImageJ. 

A análise de fractal é uma análise de complexidade. Usualmente esse termo é abstrato e 

de difícil medição, mas o plugin utiliza a definição de que complexidade é a mudança de detalhes 

à medida que se muda a escala. Ou seja, quanto mais complexo, mais detalhes uma imagem terá 

quando a escala for aumentada. Assim, é possível usar o padrão de fractal de Koch (ou curva de 

Koch) para calcular a complexidade de uma figura – ou de uma micróglia. Para fazer esse cálculo, 

o plugin FracLac calcula a dimensão de fractal (Db) para cada célula usando um protocolo de 

escaneamento em blocos que determina a quantidade de detalhes em pixel com o aumento da 

escala, onde N = número de pixels, ou “detalhe”, em uma determinada escala (ɛ); (para detalhes 

sobre o cálculo, visite https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/FractalDimension.htm#df). 

O plugin FracLac também analisa aspectos complementares da morfologia. Aqui nos 

interessa a proporção de amplitude (do inglês span ratio) e a densidade da célula. Essas medidas 

são geradas a partir de um envoltório convexo, que circunda a micróglia com um polígono e um 

círculo que limita o envoltório. A proporção de amplitude é a razão entre o maior comprimento e a 

maior largura da elipse do envoltório convexo (Figura 7.B). Ela nos dá a informação do formato 

celular, assim como de sua circularidade (quanto mais próximo de 1, mais circular). A densidade 

celular é o número de pixels contido dentro do contorno da célula dividido pela área do envoltório, 

também em pixel. Ela nos dá a informação do tamanho celular. Para evitar confusões com a 

análise de densidade feita anteriormente, chamaremos este parâmetro de “Tamanho Celular” 

daqui para frente. 

Utilizamos as mesmas imagens binárias utilizadas para a esqueletonização e convertemos 

para o contorno da célula (outline; Figura 7.C). Os resultados são decorrentes da média de 3 

células randomizadas de cada fotomicrografia. Para mais detalhes sobre a preparação das 

imagens, consulte o anexo 1.  

https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/FractalDimension.htm#df
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Figura 7: Análise fractal. (A) Imagem do escaneamento em blocos em diferentes escalas. (B) Imagem da 

análise molecular complementar à análise Fractal. (C) Imagens representativas utilizadas neste trabalho. A-

B. Adaptado de Young e Morrison (2018). 

 

3.5. Análise estatística 

A análise estatística do efeito do estresse e da idade nos animais foi feita pela ANOVA de 

duas vias (two-way ANOVA) com os dados brutos, seguida de teste Tukey como post-hoc. Para 

verificar a diferença sexual da resposta ao estresse, os grupos SM foram normalizados pelos 

respectivos Naive. Para verificar o dimorfismo sexual na dinâmica desenvolvimental (alterações ao 

longo da infância) dos animais, os grupos P30 foram normalizados pelos respectivos P15. Todas 

as análises de dimorfismo foram feitas com teste T (Student’s t test) para dados paramétricos e 

Mann-Whitney Rank Sum Test para dados não paramétricos. O programa SigmaPlot 14 foi 

utilizado para as estatísticas e o programa GraphPad Prism 9 foi utilizado para a montagem dos 

gráficos. A significância considerada foi de 0.05 (p<0.05). Os gráficos estão apresentados com 

desvio padrão e média para dados paramétricos e mediana para não paramétricos. Detalhes das 

estatísticas estão descritos nas tabelas do Anexo 2. 

 Para visualizarmos a relação entre dos parâmetros morfológicos analisados, plotamos as 

médias dos grupos em um gráfico tridimensional (x/y/z), utilizando o site www.geogebra.org. Esse 

gráfico não tem valor estatístico e é utilizado para auxiliar na interpretação nos resultados. 

Utilizamos os parâmetros “comprimento de ramificação”, “Tamanho Celular” e “Proporção de 

http://www.geogebra.org/
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Amplitude” para formulação do gráfico, uma vez que cada um representa uma característica 

morfológica distinta e não correlacionada entre si (Morrison et al., 2017). 

 

 Medida Unidade Escala Interpretação 

Comprimento 

dos processos 
Soma/Células 

µm 

/célula 

Fotomicrografia 

inteira 

Ramificação 

celular (comp.) 

“endpoints” 

das 

ramificações 

Soma/Células #/célula 

Fotomicrografia 

inteira 

Ramificação 

celular (N°) 

Dimensão de 

fractal 
𝐼𝑛𝑐𝑙𝑖𝑛𝑎çã𝑜 𝑑𝑒 𝑟𝑒𝑔𝑟𝑒𝑠𝑠ã𝑜 [

ln(𝑁)

ln(𝜀)
] 

Db Célula isolada Complexidade 

Proporção de 

amplitude 
𝑀𝑎𝑖𝑜𝑟 𝑐𝑜𝑚𝑝𝑟𝑖𝑚𝑒𝑛𝑡𝑜 𝑑𝑎 𝑒𝑙𝑖𝑝𝑠𝑒

𝑀𝑎𝑖𝑜𝑟 𝑙𝑎𝑟𝑔𝑢𝑟𝑎 𝑑𝑎 𝑒𝑙𝑖𝑝𝑠𝑒
 

Razão  Célula isolada Formato 

celular / 

circularidade 

Tamanho 

celular 

# 𝑝𝑖𝑥𝑒𝑙𝑠 𝑑𝑒𝑛𝑡𝑟𝑜 𝑑𝑜 𝑐𝑜𝑛𝑡𝑜𝑟𝑛𝑜

Á𝑟𝑒𝑎 𝑑𝑜 𝑐𝑜𝑛𝑡𝑜𝑟𝑛𝑜 𝑐𝑜𝑛𝑣𝑒𝑥𝑜
 

Pixel Célula isolada Tamanho 

celular 

Tabela 1: Resumo das análises de morfologia ln. logaritmo natural; N. Número de pixels; ɛ. Escala; Db. 

Dimensão de Fractal.  

 

 

4. RESULTADOS  

4.1. As micróglias de camundongos machos e fêmeas apresentam características 

etológicas distintas ao longo do desenvolvimento 

4.1.1.  A densidade de micróglias hipocampais diminui com a idade apenas em 

camundongos machos 

Durante o desenvolvimento, há intensa proliferação de micróglias a partir da última 

semana gestacional, com pico por volta do P14 de camundongos e posterior queda em sua 

densidade na terceira semana de vida (Nikodemova et al., 2015). Observamos a mesma dinâmica 

na densidade de micróglias em todas as áreas do hipocampo em animais machos (sub: F= 4,182, 

p=0,008; giro: F=7,848, p=0,007; CA1: F=7,364, p=0,005; CA2-3: F=10,513 p=0,012; Figura 8A-

D). Porém, fêmeas não apresentaram tal diminuição significativa na densidade de micróglias 

quando comparamos P15 e P30. Também vimos que na idade P15 a densidade de micróglias no 

subículo de machos é 52,3% maior que de fêmeas da mesma idade (F=0,800, p=0,031); e 25,5% 

maior em CA1 (F=2,295, p=0,035; Figura 8A e 8C). Por outro lado, não observamos diferença na 

densidade de micróglias hipocampais entre machos e fêmeas no P30. 
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Em seguida, analisamos possíveis diferenças na dinâmica desenvolvimental das 

micróglias nos nossos animais, em que vimos a modificação de densidade das micróglias no P30 

em relação à densidade no P15. Para isso, os dados foram normalizados pelos animais P15 de 

cada grupo. Vimos uma diferença etológica na dinâmica desenvolvimental de micróglias entre os 

sexos. Machos e fêmeas apresentam diferença na densidade do subículo (t=3,515; p=0,017), giro 

denteado (t=11,241; p<0,001) e CA1 (t=3,897; p=0,008; Figura 8E).  
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Figura 8. Diferenças sexuais etológicas na densidade de micróglias. Densidade de células (cel/mm2) 

em machos e fêmeas naive P15 e P30 no (A) subículo, (B) Giro Denteado, (C) CA1 e (D) CA2/CA3. E. Os 

dados dos grupos P30 foram normalizados pelos respectivos P15 para averiguar diferenças na dinâmica 

desenvolvimental entre animais machos e fêmeas. A-D. Two-Way ANOVA/ Tukey test; E. Teste T student; 

*p<0,05; **p<0,01; ***p<0,001. 
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4.1.2. A dinâmica desenvolvimental do comprimento das ramificações microgliais 

é sexualmente dimórfica 

Micróglias são células dinâmicas que respondem aos estímulos do microambiente neural, 

sendo uma dessas mudanças a expansão ou recolhimento de suas ramificações. As micróglias 

apresentam morfologia mais ramificada em seu estado de vigilância e recolhimento das 

ramificações em estados responsivos (Mosser et al., 2017). Durante o processo desenvolvimental 

a morfologia dessas células também se modifica (Dalmau et al., 1998), portanto, fizemos uma 

análise média das ramificações dos animais por meio do protocolo de esqueletonização das 

células. 

Vimos aumento de 19,4% no comprimento das ramificações de micróglias apenas em 

fêmeas P30 em comparação às fêmeas P15 (F=7,845; p=0,011; Figura 9A-B). O dimorfismo 

sexual se torna mais evidente na análise da dinâmica desenvolvimental, em que machos e fêmeas 

diferem no parâmetro de comprimento das ramificações (t=3,10; p=0,027). Não houve diferenças 

no número médio de ramificações ao longo do desenvolvimento em ambos os sexos (Figura 9). 
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Figura 9. Diferenças sexuais etológicas nas ramificações de micróglias. (A) Número de 

ramificações/célula de machos e fêmeas naive P15 e P30; (B) Somatória do comprimento das 

ramificações/célula de machos e fêmeas naive P15 e P30; (C) Os dados dos grupos P30 foram 

normalizados pelos respectivos P15 para averiguar diferenças na dinâmica desenvolvimental entre animais 

machos e fêmeas. A-B. Two-Way ANOVA/ Tukey test; C. Teste T student; *p<0,05. 

  

4.1.3. A dinâmica desenvolvimental do tamanho celular de microgliais é 

sexualmente dimórfica 

Micróglias são células com morfologia altamente complexa. A fim de fazer uma análise 

mais acurada de sua morfologia celular, usamos o protocolo de análise fractal para quantificar a 

complexidade celular, ou seja, seu nível de detalhamento; a proporção de amplitude, que nos 

informa sobre o formato celular ou circularidade; e a densidade da célula, uma medida de 

tamanho celular.  
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Durante o desenvolvimento do animal, no P15 e P30, não vimos modificações na 

complexidade das micróglias nem em sua circularidade. Contudo, o tamanho celular das 

micróglias hipocampais de fêmeas no P30 é 28,02% menor que no P15 (F=16,257; p=0,002; 

Figura 10A-C), diminuição que foi mais intensa em fêmeas que em machos (t=-2,929; p=0,019; 

Figura 10D). 

 

 

Figura 10. Diferenças sexuais etológicas na morfologia de micróglias. (A) Parâmetro de complexidade 

de machos e fêmeas naive P15 e P30; (B) Proporção de amplitude do círculo convexo que circunda a 

micróglia de machos e fêmeas naive P15 e P30; (C) Tamanho celular de machos e fêmeas naive P15 e 

P30, obtido através da densidade de pixel em cada célula. (D) Os dados dos grupos P30 foram 

normalizados pelos respectivos P15 para averiguar diferenças na dinâmica desenvolvimental entre animais 

machos e fêmeas. (E-F) Figuras representativas das micróglias dos grupos Naive. A-C. Two-Way ANOVA/ 

Tukey test; D. Teste T student; *p<0,05 ** **p<0,01 

 

4.2. O estresse por separação maternal impacta a densidade e morfologia de 

micróglias à curto prazo, de maneira sexualmente dimórfica 

4.2.1. O estresse na infância influencia a densidade de micróglias no subículo de 

animais P15 de maneira sexualmente dimórfica 
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A ANOVA de duas vias do giro denteado de machos detectou uma diferença no fator 

estresse (F=4,997; p=0,042), sem interação entre fatores (F=0,0025; p=0,960). Contudo, não foi 

identificada nenhuma diferença entre os grupos Naive e Separação Maternal no post-hoc. 

Igualmente, o protocolo de separação maternal não foi capaz de modificar de maneira significativa 

a densidade das micróglias em nenhuma outra região, nem em P15 nem em P30 (Figura 11A-D). 

Machos estressados na infância também apresentam diminuição na densidade de micróglias no 

P30 em relação ao P15 em todas as regiões (sub: F=29,712, p=0,005; giro: F=38,810 p<0,001; 

CA1: F=22,161 p=0,004; CA2-3: F=16,459 p=0,015; Figura 11A-D) 

Nós normalizamos os animais dos grupos SM por seus respectivos controles (Naive) para 

investigar a diferença sexual no efeito da separação maternal sobre a densidade de micróglia dos 

animais. Essa análise nos permite investigar o dimorfismo sexual da resposta ao estresse 

independentemente de eventuais diferenças basais. Micróglias presentes no subículo do 

hipocampo de camundongos machos e fêmeas responderam de maneira diferente ao estresse na 

infância. Tal diferença foi detectada logo após o estresse crônico, no P15 (t=4,664 p=0,002; Figura 

11E), mas não perdurou até o início da adolescência, no P30 (t=0,592 p=0,580; Figura 11F). 
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Figura 11. Resposta da densidade microglial ao estresse por separação maternal. Densidade de 

células (cel/mm2) em machos e fêmeas naive e separados (SM) no (A) subículo, (B) Giro Denteado, (C) 

CA1 e (D) CA2/CA3. Os dados dos grupos SM foram normalizados pelos respectivos Naive para averiguar 

diferenças na resposta ao estresse entre animais machos e fêmeas. A-D. Two-Way ANOVA/ Tukey test; E-

F. Teste T student; *p<0,05; **p<0,01; ***p<0,001.  
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4.2.2. O estresse na infância influencia a ramificação de micróglias no hipocampo 

de maneira sexualmente dimórfica    

O protocolo de separação maternal não foi capaz de modificar significativamente os 

parâmetros de ramificação estudados (Figura 12A-B).  

A modificação de ramificações em resposta ao estresse foi diferente em camundongos 

machos e fêmeas. A curto prazo, no P15, a quantidade de terminações e o comprimento das 

ramificações em resposta ao estresse foram diferentes entre machos e fêmeas (t=2,99; p=0,03 e 

t=3,1; p=0,027, respectivamente; Figura 12C). A diferença na quantidade de terminação perdurou 

até o P30 (t=-2,711; p=0,035, Figura 12D), em contraste com o seu comprimento.  
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Figura 12. Modificações na ramificação microglial em resposta ao estresse por separação maternal. 

(A) Número de ramificações/célula de machos e fêmeas Naive e separados (SM) P15 e P30; (B) Somatória 

do comprimento das ramificações/célula de machos e fêmeas Naive e separados (SM) P15 e P30; (C-D) Os 

dados dos grupos SM foram normalizados pelos respectivos Naive para averiguar diferenças na resposta ao 

estresse entre animais machos e fêmeas A-B. Two-Way ANOVA/ Tukey test; C. Teste T student; *p<0,05.  
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4.2.3. O estresse crônico na infância modifica a complexidade e tamanho celular 

de micróglias hipocampais apenas em camundongos fêmeas 

Vimos uma diminuição de 4,5% da complexidade celular de fêmeas logo após a separação 

maternal, no P15, levando a média do grupo estressado aos níveis da média dos animais P30 

(F=2,461; p=0,008; Figura 13A). Esse efeito a curto prazo do estresse também é visto no tamanho 

celular, em que fêmeas SM P15 apresentam diminuição de 23% deste parâmetro em relação ao 

grupo naive da mesma idade (F=3,516, p=0,016; Figura 13C). Machos não apresentam diferenças 

significativas nos parâmetros analisados (Figura 13A-C). A comparação da resposta ao estresse 

reflete a diferença vista entre os sexos: o tamanho celular das micróglias é modificado pela 

separação maternal de maneira diferente entre machos e fêmeas, apenas no P15 (t=-2,51; 

p=0,046; Figura 13E-F).  

 



44 
 

Figura 13. Modificações na morfologia microglial em resposta ao estresse por separação maternal. 

(A) Parâmetro de complexidade de fêmeas e machos Naive e separados (SM) P15 e P30; (B) Proporção de 

amplitude do círculo convexo que circunda a micróglia de fêmeas e machos Naive e separados (SM) P15 e 

P30; (C) Tamanho celular de fêmeas e machos Naive e separados (SM) P15 e P30, obtido através da 

densidade de pixel em cada célula. (D-E) Os dados dos grupos SM foram normalizados pelos respectivos 

Naive para averiguar diferenças na resposta ao estresse entre animais fêmeas e machos. (F-G) Imagens 

representativas das micróglias do grupo SM. A-C. Two-Way ANOVA/ Tukey test; D-E. Teste T student; 

*p<0,05; **p<0,01.  
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4.2.4. O estresse na infância altera diferenças sexuais etológicas presentes na 

densidade e morfologia das micróglias 

Por fim, fizemos a mesma análise de dinâmica desenvolvimental para animais previamente 

estressados, a fim de verificar se o estresse influencia o dimorfismo sexual observado 

anteriormente. 

No que diz respeito à densidade celular, continuamos observando a diferença na dinâmica 

desenvolvimental entre machos e fêmeas, mas os animais que passaram pelo estresse crônico 

tiveram uma leve diferença na região do CA2/3 (t = 2,552 p=0,051; Figura 14), não vista 

anteriormente em animais Naive. 

 Interessantemente, vimos uma inversão do dimorfismo sexual nos parâmetros de 

ramificação microglial. Machos naive P30 apresentaram diferença no comprimento de 

ramificações em relação às fêmeas naive da mesma idade (t=2,315 p=0,049; Figura 14), enquanto 

não houve diferença significativa no número de ramificações por célula entre os sexos. Contudo, 

machos e fêmeas que passaram pelo estresse na infância apresentaram diferença na quantidade 

de terminações no P30 (t=-3,521 p=0,013), mas perdem a diferença etológica no comprimento das 

ramificações (Figura 14). 

Já na análise detalhada da morfologia celular, animais que foram previamente estressados 

na infância deixam de apresentar a diferença sexual etológica vista anteriormente no tamanho 

celular (Naive: t=-2,929 P=0,019 x SM t=0,759 p=0,477; Figura 14). 
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Figura 14. Efeito do estresse na infância no dimorfismo sexual etológico em micróglias de 

camundongos. Os dados dos grupos P30 foram normalizados pelos respectivos P15 para averiguar 

diferenças na dinâmica desenvolvimental entre animais machos e fêmeas na densidade de animais naive 
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(A) e separados (B); nas ramificações de animais naive (C) e separados (D); e na morfologia de animais 

naive (E) e separados (F). A-F. Teste T student; *p<0,05; **p<0,01; ***p<0,001; #p=0,051.  

 

4.2.5. Micróglias de fêmeas respondem à separação maternal de 

modo a se assemelhar com a morfologia vista em machos.  

Por fim, fizemos um gráfico de dispersão de 3 dimensões (x/y/z) com a média dos grupos a 

fim de auxiliar a interpretação das modificações morfológicas vistas. Podemos perceber que o 

grupo de fêmeas naive apresenta características morfológicas diferentes dos demais grupos. 

Fêmeas naive P15 apresentam um cluster próprio, com morfologia relacionada à descrita por 

Dalmau como “micróglia tipo reativa” (Dalmau et al., 1998), que apesenta forma oval para 

arredondada, com ramificações largas e rechonchudas. Fêmeas naive P30 apresentaram 

aumento do comprimento de ramificações e diminuição do tamanho celular, condizente com uma 

morfologia de vigilância (Morrison et al., 2017). Já fêmeas SM apresentaram morfologia próxima 

ao grupo de machos independentemente da idade, com menor complexidade. Essas micróglias 

apresentam forma de vara, podendo ser interpretadas como desramificada, um estado de 

transição entre a micróglia vigilante e ameboide (Morrison et al., 2017; Gildawie et al., 2020b).  

 

 

Figura 15: Fêmeas SM apresentam morfologia mais próxima de machos que de seus controles Naive. 

Distribuição da média dos grupos de acordo com os parâmetros morfológicos. Eixo X: comprimento de 

ramificação/cel.; Eixo Y: proporção de amplitude; Eixo z tamanho celular. 

 

 



48 
 

5. DISCUSSÃO 

Nesse trabalho mostramos que as micróglias de camundongos machos e fêmeas são 

sexualmente dimórficas ao longo do desenvolvimento, em que machos apresentam maior 

densidade de micróglias no hipocampo ventral no P15. A dinâmica desenvolvimental também 

difere entre os sexos: entre o P15 e P30 fêmeas apresentam modificação da morfologia na 

direção de micróglias com morfologia de vigília, enquanto machos não apresentam modificações 

relevantes nessa faixa desenvolvimental. Apenas micróglias de fêmeas responderam ao estresse 

por separação maternal, modificando sua morfologia no P15 para uma morfologia de transição, 

mais próxima daquela observada em camundongos machos. Tais modificações persistem em 

fêmeas até o P30. 

Devido às características altamente dinâmicas das micróglias, análises morfológicas 

estáticas nos dão informações limitadas sobre seu perfil inflamatório ou sua consequência no 

microambiente neural. Contudo, a interpretação e hipóteses levantadas a partir de análises 

morfológicas são ferramentas preciosas para direcionar futuros projetos e investimentos. 

Vimos que machos P15 apresentam uma densidade maior de micróglias no subículo e 

CA1 quando comparados com fêmeas da mesma idade, mas não apresentam diferença 

significativa no início da adolescência. Gunekaya e colaboradores (2018) viram maior densidade 

de micróglias no hipocampo de camundongos fêmeas no P21 e no P91 (Guneykaya et al., 2018). 

Em uma comparação mais detalhada, Schwarz e colaboradores (2012) viram maior número de 

micróglias com processos grossos no hipocampo de ratas no P30 e P60. A discrepância de 

resultados encontrados nos animais púberes pode ser devido à utilização de animais diferentes ou 

método de análise, uma vez que o último artigo utiliza ratos e subdivide as células em diferentes 

tipos de micróglias, no qual só um tipo apresenta diferença (Schwarz, Sholar and Bilbo, 2012).  

Mais interessante que a diferença de densidade em si, é a diferença sexual na dinâmica 

desenvolvimental dos animais. Vimos que apenas machos apresentam redução da densidade 

microglial entre os 15 e 30 dias pós-natais. Estudos com animais machos mostram aumento da 

densidade de micróglias no hipocampo até a segunda semana desenvolvimental, com pico no P14 

(Dalmau et al., 1998; Kim et al., 2015); contudo poucos estudos exploram a ontogenia de 

micróglias em fêmeas. É viável a hipótese de que o pico ou o decaimento de micróglias em 

fêmeas acontece em uma janela desenvolvimental anterior comparado aos machos. Esse 

dimorfismo sexual na maturação é visto em outros sistemas neurais, como no sistema 

dopaminérgico, que sofre um atraso da maturação em machos (Stewart, Kühnemann and Rajabi, 

1991). Nelson e colaboradores viram que no P3 ratas apresentam maior número de micróglias 

fagocitárias no hipocampo e a administração de estradiol retorna seu nível para a média de 

machos (Nelson, Warden and Lenz, 2017b). Portanto, é possível que o pico de andrógenos que 
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ocorre nos primeiros dias pós-natais em roedores possa atrasar o pico de micróglias em machos 

em relação ao das fêmeas. Estudos desenvolvimentais com fêmeas em deferentes idades 

anteriores ao P15 são necessários para elucidar essa questão.  

A morfologia de machos P30 não apresenta modificações significantes em relação ao P15. 

Micróglias com morfologia típica vigilante aparecem a partir do P15 e nessa idade 

desenvolvimental grande parte das células ainda se encontram em uma morfologia classificada 

como “micróglia tipo reativa” ou "micróglia primitiva ramificada" (Dalmau et al., 1998). Vimos que 

em média as micróglias de machos apresentam morfologia alongada, típica de transição, em 

ambas as idades. É possível que as micróglias estejam fazendo essa transição de morfologia no 

período desenvolvimental em que as fotografamos. Esse resultado reitera a importância do início 

da adolescência para a maturação de diversos sistemas do cérebro, fazendo desta uma janela 

desenvolvimental de susceptibilidade a fatores externos, como estresse, traumas e infecções. 

Em fêmeas naive P15, vimos uma morfologia parecida com a categorizada por Dalmau 

como “micróglia tipo reativa”, que apesenta forma oval para arredondada, com ramificações largas 

e rechonchudas (Dalmau et al., 1998). No P30 vimos um aumento do comprimento das 

ramificações juntamente com a diminuição do tamanho/densidade celular. Essa diminuição pode 

ser um reflexo da diminuição do soma ou do afinamento dos processos, gerando um formato mais 

próximo de micróglias vigilantes no P30. Schwarz e colaboradores descreveram a predominância 

de micróglias com processos longos e grossos no hipocampo de fêmeas nessa idade, que 

permanece até o início da vida adulta, enquanto Bollinger e colaboradores (2016) mostraram um 

maior número de micróglias ramificadas em fêmeas (Schwarz, Hutchinson and Bilbo, 2011; 

Bollinger, Bergeon Burns and Wellman, 2016). 

Mais estudos precisam ser feitos para elucidar como essa diferença entre sexos implica no 

desenvolvimento fisiológico do sistema nervoso. Kopec e colaboradores (2018) mostraram que o 

amadurecimento do comportamento social em machos é dependente da poda de receptores 

dopaminérgicos por micróglias via sistema complemento no P30. Contudo, a queda dos 

receptores dopaminérgicos no núcleo acumbens ocorre antes em fêmeas e não depende desse 

sistema (Kopec et al., 2018). Ainda, diferenças sexuais moleculares não refletem necessariamente 

funções contrárias, pois vias distintas podem convergir para funções semelhantes (De Vries, 

2004). Desse modo, é possível que interferências externas na infância e adolescência modifiquem 

processos diferentes e específicos em machos e fêmeas, refletindo na susceptibilidade a 

transtornos de maneira sexo-específica.  

Interessantemente, vemos diferença em idades em que os hormônios sexuais ainda não 

apresentam grande influência. Diferenças sexuais nessa faixa podem ser decorrentes da 

expressão de genes presentes nos cromossomos sexuais Y e X, uma vez que cerca de 15% dos 
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genes escapam à inativação do X. Ainda, programações epigenéticas no início da vida podem 

fazer com que haja diferença na expressão de genes comuns de maneira dimórfica (Kodama and 

Gan, 2019). 

Em seguida, investigamos as consequências do estresse pós-natal nas micróglias de 

camundongos no início da adolescência. Escolhemos focar no hipocampo ventral pois essa parte 

está diretamente relacionada ao controle do eixo HPA e ao controle emocional, através de 

conexões com áreas límbicas como amígdala, córtex pré-frontral e núcleo acumbens 

(FANSELOW; DONG, 2010; LODGE; GRACE, 2011). 

Vimos que a separação maternal não afeta a dinâmica desenvolvimental dos animais em 

relação à densidade, contudo fêmeas e machos apresentam respostas diferentes ao estresse 

quanto à densidade no subículo. É possível que essa diferença seja reflexo do ligeiro aumento na 

média dos machos SMP15, já que fêmeas apresentam médias muito próximas entre seus os 

grupos. O aumento do poder estatístico é necessário para elucidar se esse declive é significante 

ou apenas um artefato. O aumento de apoptose de micróglias após a separação materna já foi 

relatado tanto no núcleo acumbens (Chocyk et al., 2011) no P15 quanto no hipocampo em adultos 

(Gong et al., 2018). O subículo do hipocampo faz conexões com estruturas límbicas, incluindo a 

amígdala e núcleo leito da estria terminal, além de ter projeções para núcleos hipotalâmicos 

(FANSELOW; DONG, 2010; HERMAN et al., 2005). Diferenças na densidade, junto com a 

possível ativação desigual de micróglias, podem ter impacto importante na maturação de 

sinapses, modificando circuitos sinápticos envolvidos na resposta emocional e no feedback 

negativo do eixo HPA.   

Micróglias de fêmeas e machos também respondem ao estresse na infância de maneira 

diferente em relação à média do número e comprimento de ramificação. No P15, animais 

previamente separados apresentam a média desses parâmetros muito parecida, então a forma 

como eles estão no basal, naive, é responsável pela diferença entre os sexos. É possível que a 

resposta imediata ao estresse não seja apenas no sentido de aumento ou diminuição de 

ramificação, mas sim uma mudança no desenvolvimento fisiológico da micróglia para uma 

morfologia específica, talvez mais responsiva. Isso parece ser particularmente verdade para 

fêmeas. Isso também explicaria a mudança no dimorfismo sexual em relação à dinâmica 

desenvolvimental etológica e após o estresse. A diferença etológica é a de fêmeas apresentarem 

aumento no comprimento das ramificações entre o P15 e o P30, mas nas fêmeas separadas esse 

aumento ocorreria precocemente.  

Já no P30 as médias de número de ramificações dos grupos separados são bem distintas, 

enquanto o basal, naive, é parecido. Isso sugere que possivelmente a separação maternal gera 

uma modificação a longo prazo nesse parâmetro, especialmente em fêmeas P30, mas novamente 
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é preciso aumentar o poder de análise. Isso faz com que haja uma diferença na dinâmica 

desenvolvimental entre os sexos não vista anteriormente. Seria interessante investigar o perfil de 

citocinas dos animais para saber se estão em um estado mais pró-inflamatório ou mesmo se há 

mudança no padrão de citocinas em machos, em que vimos pouca diferença em relação aos 

parâmetros de ramificação  

Para entendermos a resposta de micróglias ao estresse de maneira mais detalhada, 

fizemos a análise celular pelo plugin FracLac (ImageJ), em que obtivemos dados de complexidade 

celular, formato celular (proporção de amplitude) e densidade celular (tamanho celular). Nela, 

vimos que fêmeas P15 separadas diminuem sua complexidade e tamanho celular, compatível 

com uma morfologia mais responsiva, mas apresentam morfologia próxima de machos, 

desramificada, típica de transição. Isso pode ser explicado pois a micróglia tipo reativa descrita no 

desenvolvimento por Dalmau apresenta processos rechonchudos e largos (Dalmau et al., 1998). 

Assim, é possível que a célula desramificada seja uma passagem dessa para uma mais 

ameboide. Interessante notar que a modificação nas fêmeas SM P15 continua até o P30. 

Micróglias de fêmeas naive diminuem seu tamanho entre o P15 e P30, mas a separação materna 

faz com que o tamanho celular já seja menor no P15, novamente refletindo na diferença etológica 

inicialmente encontrada.  

Apenas com a interpretação dos parâmetros isolados, poderíamos propor que o estresse 

na infância adianta a maturação de micróglias hipocampais de fêmeas. Contudo, a visualização da 

dispersão das médias dos animais quanto a seus parâmetros morfológicos mostra que, de fato, 

fêmeas P15 e P30 separadas na infância apresentam morfologia muito semelhante, mas ambas 

ainda apresentam morfologia diferente do grupo Naive P30. Isso indica que a separação maternal 

na infância modifica a morfologia de micróglias de camundongos fêmeas no curto e longo prazo, 

diferenciando-as do seu trajeto desenvolvimental.  

Esse trabalho foi feito com camundongos transgênicos CX3CR1:GFP heterozigotos. 

Apesar desse modelo ser bem consolidado, é importante ressaltar que essa molécula está 

presente em todos os monócitos, podendo marcar também monócitos infiltrados (Jung et al., 

2000; Wolf et al., 2013). Em situações não-patológicas e com pouco ou nenhum dano à barreira 

hematoencefálica a grande maioria de monócitos no cérebro são células microgliais, que mantêm 

sua população por replicação (Ginhoux et al., 2010). Portanto, acreditamos que esse modelo é útil 

para o estudo de imagem de micróglias, refletindo majoritariamente esse grupo celular. Ainda, não 

vimos evidência de grandes infiltrados de monócitos, uma vez que vimos redução da densidade 

de micróglias em machos e não vimos nenhum impacto do estresse crônico nesse parâmetro.  

Trabalhos anteriores mostraram que a separação maternal na infância modifica o perfil de 

citocinas na idade adulta e promove o priming de micróglias (Delpech et al., 2016; Han et al., 
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2019; Catale et al., 2020). Seria proveitoso investigar se as micróglias de machos e fêmeas estão 

mais sensibilizadas ao estresse ou a inflamações já no início da adolescência. Ademais, é 

imprescindível entender a relação entre a morfologia, o perfil de citocina e a atividade fagocitária 

das micróglias em ambos os sexos. Bollinger e colaboradores identificaram que tanto o estresse 

agudo quanto crônico diminui a quantidade de micróglias vigilantes de ratas mas também 

diminuem sua atividade e perfil pró-inflamatório (Bollinger, Bergeon Burns and Wellman, 2016). 

Ademais, estudos com transcriptoma de micróglias adultas descreveram um perfil de ativação 

mais relacionado à atividade anti-inflamatória em micróglias de fêmeas (Kodama and Gan, 2019). 

Esses resultados levantam questionamentos sobre o papel das micróglias no perfil de resiliência 

ou de maior resistência à diversos protocolos de estresse, inclusive o de separação maternal 

descrito em nosso laboratório (PEÑA; NESTLER; BAGOT, 2019, Reis et al,; Menezes et al., em 

preparação). 

Por fim, esse trabalho fortifica parte da hipótese original, uma vez que o estresse por 

separação maternal modifica a morfologia de micróglia apenas de fêmeas logo após o estresse 

crônico, possivelmente com modificações perdurando até o início da adolescência. Em 

contrapartida, ele rejeita parte da hipótese no que diz respeito às modificações de densidade de 

micróglias hipocampais em resposta ao estresse. Ainda, vimos um importante dimorfismo sexual 

não só na resposta ao estresse, mas também no próprio desenvolvimento fisiológico dos animais. 

Nosso trabalho realça a importância da inclusão de modelos fêmeas na investigação de processos 

fisiológicos e em estudos translacionais envolvendo micróglias e estresse. A partir de nossos 

resultados encorajamos futuros trabalhos com técnicas mais detalhadas pra investigar se e como 

as diferenças encontradas aqui influenciam a função e desenvolvimento do hipocampo ventral de 

camundongos e sua resposta ao estresse pós-natal. 

 

6.  CONCLUSÃO 

O presente trabalho mostra que 1) micróglias do hipocampo ventral de machos e fêmeas 

apresentam dinâmica desenvolvimental distinta entre o P15 e o P30; e 2) apenas 

micróglias do hipocampo ventral de fêmeas são modificadas pelo estresse por separação 

maternal.   
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ANEXO 1: Lista de comandos do Image J para análise de imagens.  

Análise de Densidade 

• Para binarizar a imagem marcada com GFP: Image > Adjust > Threshold > Default (mais 

informações: https://imagej.net/plugins/auto-threshold ) e em seguida Process > Binary > 

Convert to Mask (mais informações: https://imagej.nih.gov/ij/docs/guide/146-29.html); 

• Na imagem de DAPI, utilize a ferramenta “freehand selection” para delimitar a sub-região 

desejada. 

• Para personalizar a análise da região: Analyze > Set Measurements. Marque “Area”.  

• Para medir a área: Analyze > Measure. Passe o resultado para uma planilha.  

• Para passar a delimitação de subárea para a imagem com GFP binarizada: Edit > 

Selection > Restore Selection 

• Para quantificar as micróglias presentes na área delimitada: Analyze > Analyze particles > 

tamanho: 6 - ꝏ µm; circularidade: 0-1. Passe o resultado para uma planilha.  

 

Análise de Ramificações - Esqueletonização 

• Para sobrepor diferentes imagens de série Z: Image > Stacks > X Project > Maximum 

Intensity Projection. Utilizamos 6 “stacks”. 

• Para ajustar o brilho e contraste, de modo a deixar as ramificações em evidência: 

Image>Adjust>Brightness/contrast; 

• Apague as ramificações das células que não apresentam o soma na imagem com a 

borracha; 

• Use o filtro “Unsharp Mask” para aumentar ainda mais o contraste: 

Process>Filters>Unsharp Mask > raio do pixel: 1; peso da máscara 0,6; 

• Para retirar o ruido feito pelo filtro, use: Process > Noise > Despeckle; 

• Para converter a imagem para binária: Image>adjust>threshold; 

• Se ainda tiverem pixels soltos ao fundo, use: Process > noise > Despeckle; Process > 

binary; e Process > noise > remove outliers (raio 2; threshold 50). Salve a imagem para a 

análise seguinte. 

• Para esqueletonizar a imagem: Process > binary > Skeletonize 

(https://imagej.net/plugins/analyze-skeleton/); 

• Para analisar: Plugins > Skeleton > Analyze Skeleton; copie os resultados e informações 

de ramificação para uma planilha. 

• Faça uma triagem dos dados para eliminar possíveis fragmentos soltos que restaram. 

Meça vários fragmentos e faça a média deles. Ordene a planilha de resultados pela coluna 

de “maximum branch lenght” e apague aqueles abaixo da média de fragmentos. Ordene a 

https://imagej.net/plugins/auto-threshold
https://imagej.nih.gov/ij/docs/guide/146-29.html
https://imagej.net/plugins/analyze-skeleton/


66 
 

planilha de informações de ramificação por “branch leght” e apague aqueles abaixo da 

média de fragmentos.  

 

Análise de Fractal 

• Pegue a imagem salva no passo anterior à esqueletonização ou repita o protocolo até o 

passo de remover os outliers; 

• Selecione uma micróglia com a ferramenta de retângulo. Atenção: o retângulo precisa ter 

as mesmas dimensões para todos os animais. Anote as dimensões ou fixe o retângulo na 

imagem com Analyze > Tools > ROI Manager > Add; 

• Abra o plugin FracLac; (mais informações: 

https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/StartUpScreen.htm)  

• Ajuste BC > num. G: 4 e marque “hull and circle”; 

• Para analisar: Scan. Salve a tabela de resultados e de “Hull and Circle” em uma planilha. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://imagej.nih.gov/ij/plugins/fraclac/FLHelp/StartUpScreen.htm
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   ANEXO 2 – TABELAS ESTATÍSTICAS 

 

TABELA 2 

Densidade 

   Subículo   Giro denteado 

Sexo Grupo  n Média Mediana SD   n Média Mediana SD 

Fêmeas 

Naive P15 3 300,09 297,94 28,73 
  3 

451,36 388,02 153,75 

SM P15 3 340,59 349,61 49,73   4 425,58 421,39 43,35 

Naive P30 4 326,75 312,92 71,17 
  4 

402,98 399,94 12,56 

SM P30 3 342,31 328,52 124,35   3 411,75 399,15 87,64 

Machos 

Naive P15 4 456,91 489,22 119,44 
  4 

568,51 584,43 110,79 

SM P15 6 373,94 364,79 19,97   6 492,32 465,21 71,68 

Naive P30 3 249,15 230,12 61,53 
  4 

359,2 357,64 21,14 

SM P30 4 233,37 235,25 15,52   4 286,38 299,79 36,54 

  CA1   CA2/3 

Sexo Grupo  n Média Mediana SD   n Média Mediana SD 

Fêmeas 

Naive P15 3 398,81 388,82 
75,36 

  
3 

409,26 436,94 147,41 

SM P15 4 389,9 390,17 22,1   4 313,95 310,15 37,25 

Naive P30 4 371,72 369,99 
28,10 

  
4 

311,32 304,52 32,42 

SM P30 3 379,21 394,56 85,73   3 304,53 319,41 55 

Machos 

Naive P15 4 568,51 584,43 
106,90 

  
4 

485,16 463,88 60,57 

SM P15 6 492,32 465,21 91,10   6 426,16 414,17 106,68 

Naive P30 4 359,2 357,64 
64,93 

  
4 

319,39 295,48 56,41 

SM P30 4 286,38 299,79 21,04   4 282,51 273,42 61,61 

Tabela 2: Dados estatísticos da análise de densidade. Dados utilizados para as análises de densidade 

expostas nas figuras 8A-D e 11A-D. Em todos os casos foi utilizado o teste Two-Way ANOVA/Tukey.  
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TABELA 3 

Dinâmica desenvolvimental - densidade 

      Subículo   Giro Denteado 

Sexo Grupo 
Normalizado 
por Média Mediana SD t p   Média Mediana SD t p 

F Naive P30 Naive P15 8,884 4,28 23,716 

3,515 0,017 

 -10,717 -11,393 2,782 

11,241 <0,001 M Naive P30 Naive P15 -45,47 -49,635 13,466  -36,818 -37,091 3,718 

                            

F SM P30 SM P15 0,501 -3,546 36,508 
3,283 0,022 

  -3,249 -6,211 20,594 
3,548 0,016 

M SM P30 SM P15 -37,592 -37,089 4,149   -41,832 -39,107 7,422 

                            

      CA1   CA2/3 

Sexo Grupo 
Normalizado 
por Média Mediana  SD t p   Média Mediana  SD t P 

F Naive P30 Naive P15 -6,79 -7,225 7,045 
3,897 0,008 

  -23,931 -25,594 7,921 
23 ⁱ 0,2 ⁱ 

M Naive P30 Naive P15 -34,131 -34,969 12,133   -34,168 -39,097 11,627 

                            

F SM P30 SM P15 -2,742 1,196 21,989 
3,283 0,022 

  -3,002 1,737 17,518 
2,552 0,051 

M SM P30 SM P15 -6,79 -7,225 7,045   -23,931 -25,594 7,921 

Tabela 3: Dados estatísticos da análise do dimorfismo sexual da dinâmica desenvolvimental - 

densidade. Dados utilizados para as análises de densidade expostas nas figuras 8E e 14A-B. Todos os 

grupos apresentam distribuição paramétrica e resultados do teste T Student, salvo CA2/3 Macho Naive P30. 

ⁱresultados do Mann-Whitney Rank Sum Test. 

 

TABELA 4 

Resposta ao estresse - densidade 

      Subículo   Giro Denteado 

Sexo Grupo Normalizado por Média Mediana SD t p   Média Mediana SD t p 

F SM P15 Naive P15 13,498 16,504 16,574 

4,664 0,002 

  -5,711 -6,639 9,605 

1,029 0,333 M SM P15 Naive P15 -18,159 -20,162 4,371   -13,401 -18,17 12,609 

                            

F SM P30 Naive P30 4,761 0,541 38,056 
0,592 0,58 

  2,176 -0,951 21,748 
1,854 0,123 

M SMP30 Naive P30 -6,334 -5,58 6,227   -20,273 -1654% 10,173 

                            

      CA1   CA2/3 

Sexo Grupo Normalizado por Média Mediana SD t p   Média Mediana SD t p 

F SM P15 Naive P15 -2,233 -2,167 5,542 

1,311 0,226 

 -23,288 -24,217 9,101 

-0,944 0,373 M SM P15 Naive P15 -13,98 -9,93 17,024  -12,162 -14,633 21,988 

                   

F SM P30 Naive P30 2,015 6,146 23,064 

1,881 0,119 

 -2,182 2,60 17,666 

0,657 0,54 M SMP30 Naive P30 -19,974 -21,326 5,97  -11,549 -14,394 19,291 
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Tabela 4: Dados estatísticos da análise do dimorfismo sexual em resposta ao estresse - densidade. 

Dados utilizados para as análises de densidade expostas nas figuras 11E-F. Todos os grupos apresentam 

distribuição paramétrica e resultados do teste T Student. 

Tabela 

5: Dados 

estatísti

cos da 

análise 

de 

ramifica

ções. 

Dados 

utilizados 

para as 

análises 

de 

ramificação expostas nas figuras 9A-B e 12A-B. Em todos os casos foi utilizado o teste Two-Way 

ANOVA/Tukey.  

 

TABELA 6 

Dinâmica desenvolvimental - Ramificações 

      N° Ramificações/Cel   Comprimento Ramificações/Cel 

Sexo Grupo Normalizado por Média Mediana SD t p   Média Mediana SD t p 

F Naive P30 Naive P15 24,12 23,46 27,49 
1,63 0,14 

  106,56 75,40 81,08 
2,32 0,05 

M Naive P30 Naive P15 -0,25 -4,42 19,07   21,13 20,63 15,41 

      
     

  
     

F SM P30 SM P15 -20,85 -19,06 15,03 
-3,52 0,01 

  3,46 14,01 25,50 
-0,50 0,64 

M SM P30 SM P15 33,01 41,33 26,65   11,56 14,01 20,40 

Tabela 6: Dados estatísticos da análise do dimorfismo sexual da dinâmica desenvolvimental- 

ramificações. Dados utilizados para as análises de ramificações expostas nas figuras 9C e 14C-D. Todos 

os grupos apresentam distribuição paramétrica e resultados do teste T Student. 

 

 

 

 

TABELA 5 

Ramificações 

   N° Ramificações/Cel   Comprimento Ramificações/Cel 

Sexo Grupo  n Média Mediana SD  n Média Mediana SD 

Fêmeas 

Naive P15 3 
29,16 28,88 5,91   3 140,48 138,28 28,37 

SM P15 3 33,28 35,57 4,44   3 210,40 222,19 25,16 

Naive P30 5 
36,19 36,00 8,02   5 290,17 246,39 113,89 

SM P30 4 26,35 26,94 5,00   4 216,55 238,62 53,37 

Machos 

Naive P15 4 
37,32 38,55 5,23   4 194,63 197,49 37,72 

SM P15 4 30,07 30,55 5,32   4 183,71 195,99 51,14 

Naive P30 5 
37,22 35,67 7,12   5 235,76 234,78 29,99 

SM P30 4 40,00 42,50 8,01   4 204,94 209,46 37,48 
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TABELA 7 

Resposta ao estresse - Ramificações 

      N° Ramificações/Cel   Comprimento Ramificações/Cel 

Sexo Grupo Normalizado por Média Mediana SD t p   Média Mediana  SD t p 

F SM P15 Naive P15 14,14 21,982 15,214 
2,999 0,03 

  48,999 58,17 17,152 

3,1 0,027 M SM P15 Naive P15 -19,414 -18,135 14,258   -5,609 0,696 26,274 

         
  

         

F SM P30 Naive P30 -27,212 -25,568 13,821 
-2,711 0,035 

  -25,37 -17,765 18,392 

1,012 0,351 M SMP30 Naive P30 7,458 14,174 21,526   -13,07 -11,156 15,897 

Tabela 7: Dados estatísticos da análise do dimorfismo sexual em resposta ao estresse – 

ramificações. Dados utilizados para as análises de densidade expostas na figura 12C. Todos os grupos 

apresentam distribuição paramétrica e resultados do teste T Student. 

 

TABELA 8 

Morfologia (FracLac) 

   Complexidade   Proporção de Amplitude   Tamanho 

Sexo Grupo  n Média Mediana SD   n Média Mediana SD   n Média Mediana SD 

Fêmeas 

Naive P15 3 1,56 1,54 0,048 
  

3 1,44 1,41 0,075 
  

3 
0,106 0,102 0,018 

SM P15 3 1,49 1,49 0,030   3 1,58 1,69 0,214   3 0,082 0,080 0,006 

Naive P30 5 1,52 1,52 0,014 
  

5 1,38 1,36 0,101 
  

5 
0,076 0,074 0,008 

SM P30 4 1,49 1,48 0,017   4 1,64 1,58 0,260   4 0,080 0,082 0,009 

Machos 

Naive P15 4 1,55 1,55 0,028 
  

4 1,39 1,40 0,111 
  

4 
0,097 0,097 0,010 

SM P15 5 1,54 1,52 0,040   5 1,41 1,48 0,162   5 0,100 0,093 0,016 

Naive P30 5 1,53 1,53 0,039 
  

5 1,42 1,43 0,040 
  

5 
0,084 0,089 0,008 

SM P30 4 1,55 1,53 0,066   4 1,66 1,65 0,378   4 0,092 0,090 0,010 

Tabela 8: Dados estatísticos da análise de morfologia. Dados utilizados para as análises morfológicas 

expostas nas figuras 10A-C e 13A-C. Em todos os casos foi utilizado o teste Two-Way ANOVA/Tukey 
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Tabela 9: Dados estatísticos da análise do dimorfismo sexual da dinâmica desenvolvimental - 

Morfologia. Dados utilizados para as análises morfológicas expostas nas figuras 10D e 14E-F. Todos os 

grupos apresentam distribuição paramétrica e resultados do teste T Student 

 

TABELA 9 

Dinâmica Desenvolvimental - Morfologia  

      Complexidade   Proporção de Amplitude 

Sexo Grupo Normalizado por Média Mediana SD t p   Média Mediana  SD t p 

F Naive P30 Naive P15 -1,044 -2,69 4,314 
0,214 0,836 

  -4,398 -5,249 6,991 
-2,058 0,074 

M Naive P30 Naive P15 -1,52 -1,55 2,482   2,571 3,29 2,911 

      
     

  
     

F SM P30 SM P15 -0,142 -0,44 1,106 
0,484 0,646 

  3,646 0,37 16,466 
-0,91 0,398 

M SM P30 SM P15 0,93 -0,157 4,29   18,009 17,44 26,914 

                            

      Tamanho       

Sexo Grupo Normalizado por Média Mediana  SD t p 
      

F Naive P30 Naive P15 -28,04 -29,918 8,005 
-2,929 0,019       

M Naive P30 Naive P15 -13,221 -8,08 7,995       

      
     

      

F SM P30 SM P15 -2,15 0,783 10,428 
0,759 0,477       

M SM P30 SM P15 -7,652 -10,11 10,084       

TABELA 10 

Resposta ao estresse - Morfologia  

      Complexidade   Proporção de Amplitude 

Sexo Grupo Normalizado por Média Mediana  SD t p   Média Mediana  SD t p 

F SM P15 Naive P15 -4,579 -4,479 1,89 
-1,968 0,097 

  -23,025 -24,859 6,072 
-2,514 0,046 

M SM P15 Naive P15 -1,173 -2,066 2,576   2,654 -469% 16,586 

                            

F SM P30 Naive P30 -2,059 -2,35 1,085 
-1,506 0,183 

  4,671 7,804 11,15 
-0,56 0,596 

M SMP30 Naive P30 1,285 0,194 4,305   9,24 6,339 11,93 

                            

      Tamanho       

Sexo Grupo Normalizado por Média Mediana  SD t p 
      

F SM P15 Naive P15 9,658 17,338 14,844 
18ⁱ 0,25ⁱ       

M SM P15 Naive P15 1,542 6,70 11,677 
      

                      

F SM P30 Naive P30 18,885 15,129 18,887 
0,126 0,904       

M SMP30 Naive P30 16,826 16,26 26,644       
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Tabela 10: Dados estatísticos da análise do dimorfismo sexual em resposta ao estresse - Morfologia. 

Dados utilizados para as análises morfológicas expostas na figura 13D. Todos os grupos apresentam 

distribuição paramétrica e resultados do teste T Student, salvo SP15. ⁱresultados do Mann-Whitney Rank 

Sum Test 


